MS EXCEL

Excel 2003 is the spreadsheet software in the Microsoft 2003 Office Suite. It allows you
to store, organize, and analyze numerical information.




The Excel Window

Many items you see on the Excel 2003 screen are standard in most other Microsoft
software programs like Word, PowerPoint and previous versions of Excel. Some
elements are specific to this version of Excel.
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Workbook

Also called a spreadsheet, the Workbook is a unique file created by Excel.

Title bar
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The Title bar displays both the name of the application and the name of the spreadsheet.




Menu bar
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The Menu bar displays all the menus available for use in Excel 2003. The contents of any

menu can be displayed by clicking on the menu name with the left mouse button

Toolbar

Some commands in the menus have pictures or icons associated with them. These
pictures may also appear as shortcuts in the Toolbar.
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Each Excel spreadsheet contains 256 columns. Each column is named by a letter or
combination of letters.

Row Headings
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Each spreadsheet contains 65,536 rows. Each row is named by a number.
Name Box
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Shows the address of the current selection or active cell.




Formula Bar

)

Displays information entered-or being entered as you type-in the current or active cell.
The contents of a cell can also be edited in the Formula bar.

Cell
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A cell is an intersection of a column and row. Each cell has a unique cell address. In the
picture above, the cell address of the selected cell is B3. The heavy border around the
selected cell is called the cell pointer.

Navigation Buttons and Sheet Tabs
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Navigation buttons allow you to move to another worksheet in an Excel workbook. Used
to display the first, previous, next or last worksheets in the workbook.

Sheet tabs separate a workbook into specific worksheets. A Workbook defaults to three
worksheets. A Workbook must contain at least one worksheet.




Workbooks and Worksheets

A Workbook automatically shows in the workspace when you open Microsoft Excel
2003. Each workbook contains three worksheets. A worksheet is a grid of cells,
consisting of 65,536 rows by 256 columns. Spreadsheet information--text, numbers or
mathematical formulas--is entered in the different cells.
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Column headings are referenced by alphabetic characters in the gray boxes that run
across the Excel screen, beginning with the Column A and ending with Column IV.

Rows are referenced by numbers that appear on the left and then run down the Excel
screen. The first row is named Row 1 and the last row is named 65536.

# Important Terms

« A workbook is made up of three worksheets.

+ The worksheets are labeled Sheetl, Sheet2, and Sheet3.

« Each Excel worksheet is made up of columns and rows.

« In order to access a worksheet, click on the tab that says Sheet#.




The Cell

An Excel worksheet is made up of columns and rows. Where these columns and rows
intersect, they form little boxes called cells. The active cell, or the cell that can be acted
upon, reveals a dark border. All other cells reveal a light gray border. Each cell has a
name. Its name is comprised of two parts: the column letter and the row number.
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In the following picture the cell C3, formed by the intersection of column C and row 3,
contains the dark border. It is the active cell.
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» Important Terms

» Each cell has a unique cell address composed of a cell's column and row.
« The active cell is the cell that receives the data or command you give it.
« A darkened border, called the cell pointer, identifies it.




Moving Around The Worksheet

You can move around the spreadsheet in several different ways.

To Move the Cell Pointer:

« To activate any cell, point to a cell with the mouse and click.
« To move the pointer one cell to the left, right, up, or down, use the keyboard
arrow keys.

To Scroll Through the worksheet:
The vertical scroll bar located along the right edge of the screen is used to move up or

down the spreadsheet. The horizontal scroll bar located at the bottom of the screen is
used to move left or right across the spreadsheet.
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To Move between worksheets
As mentioned, each Workbook defaults to three worksheets. These worksheets are
represented by tabs-named Sheetl, Sheet2 and Sheet3-that appear at the bottom of the
Excel window.
To Move from one worksheet to another worksheet:
+  Click on the sheet tab (Sheetl, Sheet2 or Sheet 3) that you want to display
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Understanding File Terms

The File menu contains all the operations that we will discuss in this lesson: New, Open,
Close, Save and Save As.
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New

Used to create a new Workbook.

Open

Used to open an existing file from a floppy disk or hard drive of computer.
Close

Used to close a spreadsheet.

Save As

Used when to save a new file for the first time or save an existing file with a different
name.




Save

Used to save a file that has had changes made to it. If you close the workbook without
saving then any changes made will be lost.

Creating A Workbook

A blank workbook is displayed when Microsoft Excel is first opened. You can type
information or design a layout directly in this blank workbook.

To Create an Excel Workbook:

« Choose File = New from the menu bar.
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« The New Workbook task pane opens on the right side of the screen.
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Choose Blank Workbook under the New category heading.

A blank workbook opens in the Excel window. The New Workbook task pane is
closed.

Insert A New Worksheet

Add a single worksheet
« Click Worksheet on the Insert menu.
Add multiple worksheets
Determine the number or worksheets you want to add.

1. Hold down SHIFT, and then select the same number of existing worksheet tabs
that you want to add in the open workbook.




Example: If you want to add three new worksheets, select three existing

worksheet tabs.

2. Click Worksheet on the Insert menu.
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Open A File
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file you want to open.

If you can't find the file, you can search for it.
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In your Microsoft Office program, click File, and then click Open.
In the Look in list, click the drive, folder, or Internet location that contains the

In the folder list, locate and open the folder that contains the file.

To limit where to search, in the Search in box, select one or more

drives, folders, Web sites, or Outlook mailboxes. To search
everywhere, select Everywhere. To specify a single drive, folder,
or Web site, type it directly in the Search in box.

To limit the types of search results, in the Results should be box,

select the types of files, Web pages, and Outlook items to find. To
find all types of files and items, select Anything.
3. Click Search.
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Giving the path or double click open the file

Saving a workbook

Every workbook created in Excel must be saved and assigned a name to distinguish it
from other workbooks. The first time you save a workbook, Excel will prompt you to
assign a name through the Save As operation. Once assigned a name, any additional
changes made to the text, numbers or formulas need to be saved using the Save

operation.

To Save a new Workbook:




Choose File = Save As from the menu bar.

Choose the Save As command
when saving an Excel file for
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the first time.

The Save As Dialog Box appears.

Click on the Save In: dropdown menu and locate where the file will be saved.
Choose Local Disk (C:) to save the file to your computer.

Type a name for your file in the File Name: box.

Click the Save button.
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To Save Changes Made to an Existing Workbook:

+ Choose File = Save from the menu bar, or

Click the & Save button on the Standard toolbar.

Closing a Workbook

To close an existing Excel 2003 Workbook:

+ Choose File = Close from the menu bar. The workbook in the Excel window is
closed.
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v" Excel 2003 will prompt you to save information if any has been typed between the
last save and the time you close the file.
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Rename a file

On the Standard toolbar, click Open

Click a shortcut on the Places Bar, or in the Look in box, click the drive or folder

that contains the file you want to rename.

3. In the folder list, locate and open the folder that contains the file you want to
rename.

4. Right-click the file you want to rename, and then click Rename on the shortcut
menu.

5. Type the new name, and then press ENTER.
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Rename a sheet

1. To rename the active sheet, on the Format menu, point to Sheet and then click
Rename.

2. Type the new name over the current name.




Entering Text in a Cell

You can enter three types of data in a cell: text, numbers, and formulas. Text is any
entry that is not a number or formula. Numbers are values used when making
calculations. Formulas are mathematical calculations.

To Enter Data into a Cell:

+  Click the cell where you want to type information.
« Type the data. An insertion point appears in the cell as the data is typed.

SUe 454 Street

[T T l555 Street

Insertion point
« The data can be typed in either the cell or the Formula bar.

Text can be entered in the cell ar in the Formula bar.
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« Data being typed appears in the both active cell and in the formula bar.
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Text appears in hoth active cell and in the Formula Bar as it is typed.




« Notice the Cancel and Enter buttons in the formula bar.

Mame box Fomula bar
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«  Click the Enter button ‘¥ to end the entry and turn off the formula bar buttons.
v’ Excel's AutoComplete feature keeps track of previously-entered text. If the first few

characters you type in a cell match an existing entry in that column, Microsoft Excel fills
in the remaining characters for you.

Editing Information in a Cell

Information in a spreadsheet is likely to change over time. Information can be changed in
either of two ways.

Quick and Easy Method:

«  Click the cell that contains the information to be changed.
« Type the new entry. The old entry is replaced by the new entry.

If the original entry is long and requires only a minor adjustment (in spelling, for
example), then you can directly edit the information in the cell.

To Edit Information in a Cell:
Method 1: Direct Cell Editing

« Double-click on the cell that contains the information to be changed.
« The cell is opened for direct editing.
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1 |First Name Last Name Address Phone
2 |Jaohn Jones 123 Street 595-5555
3 [Jane Smith 345 Street 5595-1234
4 |Jok IS rnith 456 Street 555-5678

Double-click on the cell and edit information
directly in the cell

« Make the necessary corrections.




«  Press Enter or click the Enter button on the Formula bar ' to complete the
entry.

Method 2: Formula Bar Editing

+  Click the cell that contains the information to be changed.
- Edit the entry in the formula bar.
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Deleting Information in a Cell

To Delete Data that Already Appears in a Cell:

o Click the cell that contains the information to be deleted.
« Press the Delete key, or




Right-click and choose Clear Contents from the shortcut menu.
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To Delete Data Being Typed But Not Yet Added to the Cell:

« Cancel an entry by pressing the Escape key.

Performing Undo and Redo

Sometimes, you might do something to a spreadsheet that you didn't mean to do, like
type the wrong number in a cell. Excel 2003 allows you to undo an operation. Use the

)7 Undo button on the Standard toolbar to recover an error. The last single action is

recoverable.

To Undo Recent Actions (typing, formatting, etc), One at a Time:

«  Click the “2 " Undo button.




To Undo Several Recent Actions at Once:

«  Click the arrow next to the Undo button.
« Select the desired Undo operation(s) from the list.
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« Microsoft Excel reverses the selected action and all actions that appear in the list
above it.

An Undo operation can be cancelled by applying a Redo. This is useful when an Undo
operation was mistakenly applied. Remember, a Redo is possible only if you have not
changed an Excel spreadsheet since the last Undo operation was completed:

To Redo an Undo Operation:

. Press the © " Redo button.

To Redo several recent Undo actions at once:
o Click the arrow next to Redo button.

« Select the desired Redo operation from the list.
«  Microsoft Excel reverses the Undo operation.

Selecting Multiple Cells

The currently-selected cell in Excel is called the active cell. You can also select a group
of adjacent cells, or a cell range. Many operations can be done against a cell range: move




it, copy, it, delete it or format it. A cell range can be defined in different ways: select a
specific range of cells, select multiple columns or rows, or select the entire worksheet.

To Select a Range of Cells:

«  Move to the first cell in the range.

« The mouse pointer becomes a large cross.

 Click-and-hold the left mouse button and drag left or right, up or down to the last
cell you want to select.

« Release the mouse button.

« The cells you selected are shaded.
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_1 |First Name Last Name Address Phone
_2 |John Jones 123 Street 555-5555
_3 |ane =mith 345 Street 555-1234
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To Select All Cells in a Column or Row:

+  Click the gray Column heading to select the entire column. (Click and drag the
cursor across other column headings to select those columns).
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Johir Jones 123 Street|555-5555
Jarne Srmith 345 Street 655-1234
Joe Srmith 456 Street 555-5678
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Click on the gray column heading
to select the enfire colummn.

« Click the gray Row heading to select the entire row. (Click and drag the cursor
down through the row headings select those rows).
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1 |First Name Last Name Address Phone
2 [John Jones 123 Street 555-5555
Jane Smith 345 Street 555-1234
4 |Joe Smith 456 Street 555-5670
o

Click on the gray row heading to select the entire row.




To Select the Entire Worksheet:
« Click the gray rectangle in the upper left corner to select entire worksheet.
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Click on the gray rectangle to
select the entire worksheet.

v If the cells and columns you want to select are not directly next to one another, select
one of the ranges you want to select, and hold down the Control key while selecting
other ranges.
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First Name Last Name Address
John Jones 123 Street 555-5555
Jane Smith 345 Street 555-1234
Joe Smith 456 Street 565-5678
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Cut, copy. paste defined

Cut, Copy and Paste are very useful operations in Excel. You can quickly copy and/or
cut information in cells (text, numbers or formulas) and paste them into other cells. These
operations save you a lot of time from having to type and retype the same information.

The Cut, Copy and Paste buttons are located on the Standard toolbar.

Cut, Copy, and Paste Buttons on the Standard Toolbar
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The Cut, Copy and Paste operations also appear as choices in the Edit menu:




Edit

View  Insert  Formal
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The Cut, Copy and Paste operations can also be performed through shortcut keys:

Undo Clear  Crrl+2

Cuk Chrl+%
Copy Chrl4+iC
Office Clipboard...

Paste Chrl+y

Paste Special...

Cut Ctrl+X
Copy Ctrl+C
Paste Ctrl+V

Copy and Paste Cell Contents

The Copy feature allows you to copy selected information from the spreadsheet and
temporarily place it on the Clipboard, which is a temporary storage file in your
computer's memory. The Paste feature allows you to select any of the collected items on
the Clipboard and paste it in a cell of the same or different spreadsheet.

To Copy and Paste:

- Click on the =2 Copy button on the standard toolbar.
The border of the copied cell(s) takes on the appearance of marching ants.

Select a cell or cells to be duplicated.
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+  Click on the cell where you want to place the duplicated information. The cell
will be highlighted. If you are copying contents into more than one cell, click the
first cell where you want to place the duplicated information.
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« Press the Enter key. Your information is copied to the new location.

v’ Be careful if you paste copied cell information into cells that already contain data. If
you do, the existing data is overwritten.

v’ You can copy information from many different sources including Web sites, emails or
other Office applications like Word and PowerPoint and paste it into an Excel
spreadsheet.

Cut and Paste Cell Contents

The Cut feature allows you to remove information from cells in the spreadsheet.
Information that is cut can be pasted in another cell, as long as the pasting occurs before
you perform another operation. If you don't paste the cut information immediately, it is
removed from the Office clipboard.

To Cut and Paste:

« Select a cell or cells to be cut.

«  Click on the Cut \#. button on the Standard toolbar.

« The information in the cell is deleted.

« The border of the cut cell(s) take on the appearance of marching ants.

+  Click on the cell where you want to place the duplicated information. The cell
will be highlighted. If you want to paste the contents into more than one cell,
click the first cell where you want to place the duplicated information.
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« Press the Enter key. Your information is pasted to the new location.

v" You do not have to paste information that has been cut. You can use Cut to delete
information from a cell.

Moving Information Using Drag-and-Drop

Another way to move information from one cell to another is to use the drag-and-drop
method. You use the cursor to point to the information to be moved and then drag the cell

to its new location.

To Use Drag and Drop:

« Highlight and select the cell(s) you want to move to a new location.

« Position the mouse pointer near one of the outside edges of the selected cell(s).
The mouse pointer changes from a large, white cross and becomes a slender,
black cross with arrows at all ends.

A | B | c© | A | B | C |
1 1
2 |Savings 2451 2 |Savings + 2481
3 oo 3
4 Large, white cross 4 Slender, black cross
a g with arrows at all ends

« Keep the mouse pointer on the outer edge of the selected cell, click and hold the
left mouse button and drag the cell(s) to a new location.




A | B | ¢ | 0 [ E |

Savinmgs 245!

« Release the mouse button to move the information to its new location.
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Find Text or Numbers

1. Select the range of cells you want to search.

If you want to search the entire worksheet, click any cell.
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Note

On the Edit menu, click Find.
In the Find what box, enter the text or numbers you want to search for or choose
a recent search from the Find what drop down box.

Note You can use wildcard characters in your search criteria.

If you want to specify a format for your search, click Format and make your
selections in the Find Format dialog box.

If Format is not available in the Find and Replace dialog box, click Options
and then click Format.

Click Options to further define your search. For example, you can search for all
of the cells that contain the same kind of data, such as formulas.

In the Within box, you can select Sheet or Workbook to search a worksheet or
an entire workbook.

Click Find All or Find Next.
Find All lists every occurrence of the item you are searching for and allows you
to make a cell active by selecting a specific occurrence. You can sort the results of

a Find All search by clicking a header.

To cancel a search in progress, press ESC
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Insert a new worksheet

Add a single worksheet
+ Click Worksheet on the Insert menu.
Add multiple worksheets
Determine the number or worksheets you want to add.

1. Hold down SHIFT, and then select the same number of existing worksheet tabs
that you want to add in the open workbook.

Example: If you want to add three new worksheets, select three existing
worksheet tabs.

2. Click Worksheet on the Insert menu.
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Insert a Symbol

You can use the Symbol dialog box to enter symbols that are not on your keyboard, as
well as Unicode characters.

If you’re using an expanded font, such as Arial or Times New Roman, the Subset list
appears. Use this list to choose from an extended list of language characters, including
Greek and Russian (Cyrillic), if available.

About Formulas

In school, you learned formulas used to calculate math problems. Microsoft Excel uses
these same formulas to perform calculations in a spreadsheet.

A formula can be a combination of values (numbers or cell references) and math
operators (+, -, /, *, =) into an algebraic expression. Excel requires every formula to
begin with an equal sign (=).

The following table illustrates the mathematical operators learned in school and those
represented in Excel 2003.




School Excel 2003
Addition H +
Subtraction - -
Multiplication X *
Division
Equals = =

The result of a formula-the answer to 2+3, for example-displays in the cell on the Excel
worksheet. The formula is visible only in the formula bar. A formula's result will change
as different numbers are entered into the cells included in the formula's definition.

B * X J & SUM(B1:E3)

Creating a Simple Addition Formula

A simple formula in Excel contains one mathematical operation only: one number plus a
second number equals a third number. Writing a simple formula is really no more
difficult than that: 1+1. The only difference in Excel is that all formulas must begin with
the equal sign (=). It is not enough to type 1+1 in Excel because what will appear in the
cell is "1+1." You must begin the equation with an equal sign, or =1+1. This holds true
for any formula, simple or complicated, that adds, subtracts, multiplies or divides.

Let's add two numbers to create a third, 128+345=473. In Excel, this would be expressed
by the formula, =128+34S5, as shown below.

B2 - B =1284+345
A | B | ¢ | D |
1
2 4?3_
3 The formula, =128+345,
4 |produces an answer of 473,

To Create a Simple Formula that Adds Two Numbers:

+  Click the cell where the formula will be defined.

« Type the equal sign (=) to let Excel know a formula is being defined.

« Type the first number to be added (128, for example)

« Type the addition sign (+) to let Excel know that an add operation is to be
performed.

« Type the second number to be added (345, for example

« Press Enter or click the Enter button on the Formula bar to complete the
formula.




But what if a column contains many numbers, each of which regularly changes? You
don't want to write a new formula each time a number is changed. Luckily, Excel 2003
lets you include cell references in formulas.

A formula can add the value of two cells-B2 and B3, for example. Type any two values in
these two cells and the formula will adjust the answer accordingly.

Using this method to calculate two numbers-128 and 345, for example-requires that you
type 128 in cell B2, for example, and 345 in cell B3. The Excel formula, =B2+B3, would
then be defined in cell B4.

Sl > X o A& =SUM(B2+B3)
A | B | ¢ | D |
1
2
3
4 |=SUM({B2+E3)
]
3]
BS - T
Type the
formula, =B2+B3, A | B | ¢ | D |
in cell B4 and 1
press Enter to see 2 125
the result. 3 e
4 473
5
[ ]
B

To Create a Simple Formula that Adds the Contents of Two Cells:

« Type the numbers you want to calculate in separate cells (for example, type 128
in cell B2 and 345 in cell B3).

+  Click the cell where the answer will appear (B4, for example).

« Type the equal sign (=) to let Excel know a formula is being defined.

« Type the cell number that contains the first number to be added (B2, for

example).

« Type the addition sign (+) to let Excel know that an add operation is to be
performed.

« Type the cell number that contains the first number to be added (B3, for
example).

« Press Enter or click the Enter button on the Formula bar to complete the
formula.




Creating a Simple Subtraction Formula Using the Point-and-
Click Method

Formulas can be created by using either numbers or cell references in the definition. You
can also use the mouse to select the cells to be used in the formula instead of typing the
cell number or cell reference. Using this method, we are going to write a simple formula
that subtracts one cell from another: =B3-B2.

SWERAGE |+ M o & =B3-B2

A | B | ¢ T D [ E ]
; fp”h___ﬁré* Formula =B3-B2 subtracts
AR 4~ ila =BJ3-
3 34§i cell B3 from cell B2.
4 =B3-B2 l
o
G

To Create a Simple Formula using the Point and Click Method:

«  Type the numbers you want to calculate in separate cells (for example, type 128
in cell B2 and 345 in cell B3).

«  Click the cell where the answer will appear (B4, for example).

« Type the equal sign (=) to let Excel know a formula is being defined.

«  Click on the first cell to be included in the formula (B3, for example).

« Type the subtraction sign (-) to let Excel know that a subtraction operation is to
be performed.

«  Click on the next cell in the formula (B2, for example).

« If you include multiple cells in the formula, repeat steps 4 and 5 until the entire
formula is entered.

« Press Enter or click the Enter button on the Formula bar to complete the
formula.

Creating Simple Multiplication Formulas

Creating multiplication formulas is very similar to addition and subtraction formulas. To
multiply two cells the formula, B2 and B3, you would need to insert a multiplication
operator * between them, =B2*B3.

A

B

Formula =B2*B3 multiplies
o cell BZ by the cell B3
=B2*B3 |

c [ b | E |

oM = k| —




To Create a Simple Formula that Multiplies the Contents of Two Cells:

« Type the numbers you want to calculate in separate cells (for example, type 128
in cell B2 and 345 in cell B3).

+  Click the cell where the answer will appear (B4, for example).

« Type=

+  Click on the first cell to be included in the formula (B2, for example).

« Type a mathematical operator (Ex: the multiplication symbol *). The operator
displays in the cell and Formula bar.

« Click on the next cell in the formula (B3, for example).

« If you include multiple cells in the formula, repeat steps 4 and 5 until the entire
formula is entered.

« Press Enter or click the Enter button on the Formula bar to complete the
formula.

Creating Simple Division Formulas

Creating division formulas is very similar to the addition, subtraction and multiplication
formulas. To divide the contents of cell B2 by cell B3, you would need to insert a
division operator / between them, =B2/B3.

To Create a Simple Formula that Divides One Cell by Another:

A | B | c | b | E |

S Eﬁl Formula =B2/B3 divides cell
{ 345 BZ by cell B3

L P i ol

|=EEEIEE l

oM = L kD —

« Type the numbers you want to calculate in separate cells (for example, type 128
in cell B2 and 345 in cell B3).

«  Click the cell where the answer will appear (B4, for example).

« Type the equal sign (=) to let Excel know a formula is being defined.

«  Click on the first cell to be included in the formula (B2, for example).

« Type a mathematical operator (Ex: the division symbol /). The operator displays
in the cell and Formula bar.

« Click on the next cell in the formula (B3, for example).

« If you include multiple cells in the formula, repeat steps 4 and 5 until the entire
formula is entered.

« Very Important: Press Enter or click the Enter button on the Formula bar. This
step ends the formula.




Creating Complex Formulas

Excel 2003 automatically follows a standard order of operations in a complex formula. If
you want a certain portion of the formula to be calculated first, put it in parentheses.

If we wanted to add the contents of cell B2 and cell B3, for example, and then take that
answer and multiply it by the data in cell A4, then we would need to define the following
formula: =(B2+B3)*A4.

SUM ~ X & =(B2+B37A4
A | B | ¢ | o [ E | F |
34
3

|:£52+53!*,&,,4| The formula =({B2+B3)"A4 first adds
™ 128 and 345 and then multiplies

the answer by 97.

D |~ || = | LD R —

« Enter the numbers you want to calculate.

«  Click the cell where you want the formula result to appear.

« Type the equal sign (=) to let Excel know a formula is being defined.

« Type an open parenthesis, or (

« Click on the first cell to be included in the formula (cell B2, for example).

« Type the addition sign (+) to let Excel know that an add operation is to be
performed.

«  Click on the second cell in the formula. The reference B3 displays where you
want your result.

« End the B2+B3 operation by adding the close parenthesis, or )

« Type the next mathematical operator, or the multiplication symbol (*) to let
Excel know that an multiply operation is to be performed.

+  Click on the third cell to be included in the formula, cell A4.

«  Very Important: Press Enter or click the Enter button ‘¥ on the Formula bar.
This step ends the formula.

v’ Try changing one of the values in the formula and watch the answer to the formula
change.




Filling Formulas to Other Cells

Sometimes, you will write a formula that gets used a lot in different places of a
worksheet. For example, a spreadsheet may contain several columns of numbers. Each
column will contain a formula that adds all the numbers in it. You could write the
formula several times, once in each column. Or you could copy-and-paste it into each
column. The fill formula method allows you to copy a formula and fill it into many
different consecutive cells at the same time.

The mouse pointer changes to a black crosshair when passed over the fill handle, or the
square box in the lower right corner of the cell.

BS - & =(B2+B3)"Ad
A | B | ¢ | D | E | F

1
2 128
3 345
4 a7
5 )
G The mouse pointer changes to
7 a black cn:_:-rsshair when passed
5 over the fill handle.
9 Fill Handle
10
11
12

To Use the Fill Handle to Copy a Formula to a Surrounding Cell:

«  Click on the cell that contains the formula to be copied.

« Position the mouse pointer over the fill handle.

« Click and hold the left mouse button, and then drag the contents to the cell that's
to receive the fill formula.

« Release the mouse button.




« Select the Copy Cells option in the fill formula drop-down menu.

Bs - A =(B2+B3)"A4
A | e | ¢ | b | E | F | 6 | H

1

2 128

3 345

4 97

5 [ 455881 0 0 ol

2] .

7

g Copy Cef

H Copy the formula in cell BS and fll it G} Fill Earmatting Only

10 into cells C5, D5, and ES. O Fill without Farmatting

11 —

12

The cell references in a formula are automatically updated when the formula is copied to
other cells in the spreadsheet.

Copy and Paste Formulas

The process to copy and paste a formula is identical to that process used to copy and
paste text.

To Copy and Paste a Formula:

« Select the cell that contains the formula to be copied.

«  Click the =2 Copy button. Marching "ants" appear around the copied cell(s).

E Microsoft Excel - Book?

Eﬂ File Edit ‘Miew Insert Formak  Tools D

SRRER" RERE = NEN AN N

i Arial -0 ~| B JF U=
=1 - & =SUM(EZ-B3)
A 8 | ¢ [ 0D
; Sales 34567
J |Expenses 1234
g E 33,333;

hlarching ants appear during the copy process

« Select the cell where the copied formula is to be pasted.




« Press the Enter key. The formula is copied to the new location.

Revising Formulas

You can revise any formula that was previously written in a worksheet.

To Revise a Formula using the Keyboard:

« Double-click the cell that contains the formula you want to revise.
« The cursor can now move left and right between the values in the formula in cell

BS.
S - X J A& =B.+E3
A E | ¢ | D
1
2 |Sales 34 567.00
3 |Expenses 1,234.00] 35124.00
4
5 =B2+B3
; |
7
a To replace cell B2 with cell C3 in your
formula, type C3 where B2 appears
g and then delete B2.
10
11

« Make the necessary changes to the formula.
« Press the Enter key or click the Enter button to accept the new formula.

Using Functions

A function is a pre-defined formula that helps perform common mathematical
functions. Functions save you the time of writing lengthy formulas. You could use an
Excel function called Average, for example, to quickly find the average of range of
numbers. Or you could use the Sum function to find the sum of a cell range. Excel 2003
contains many different functions.

Each function has a specific order, called syntax, which must be strictly followed for the
function to work correctly.

Syntax Order:

1. All functions begin with the = sign.
2. After the = sign define the function name (e.g., Sum).




3. One or more arguments-numbers, text or cell references-enclosed by
parentheses. If there is more than one argument, separate each by a comma.

An example of a function with one argument that adds a range of cells, B3 through B10:
,=Sl|JM(B3:B'I 0)
ey g T

equal sign  function name  argument

An example of a function with more than one argument that calculates the average of
numbers in a range of cells, B3 through B10, and C3 through C10:

~AVG(B3:B10, C3:C10)

equal sign  function name  argument

Excel literally has hundreds of different functions to assist with your calculations.
Building formulas can be difficult and time-consuming. Excel's functions can save you a
lot of time and headaches.

Excel's Different Functions

There are many different functions in Excel 2003. Some of the more common functions
include:

Statistical Functions:

« SUM - summation adds a range of cells together.

« AVERAGE - average calculates the average of a range of cells.
« COUNT - counts the number of chosen data in a range of cells.
«  MAX - identifies the largest number in a range of cells.

« MIN - identifies the smallest number in a range of cells.

Finding the Sum of a Range of Data

The AutoSum function allows you to create a formula that includes a cell range-many
cells in a column, for example, or many cells in a row.
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B2 - B 128
A B | ¢ | b | _E—T F | G |
1
2
3 Highlight the range of numbers to be added
4 and click the AutoSum button in the
5 standard toolbar.
G
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To Calculate the AutoSum of a Range of Data:

Type the numbers to be included in the formula in separate cells of column B (Ex:
type 128 in cell B2, 345 in cell B3, 243 in cell B4, 97 in cell BS and 187 cell B6).
Click on the first cell (B2) to be included in the formula.

Using the point-click-drag method, drag the mouse to define a cell range from
cell B2 through cell B6.

On the Standard toolbar, click the Sum button.

The sum of the numbers is added to cell B7, or the cell immediately beneath the
defined range of numbers.

Notice the formula, =SUM(B2:B6), has been defined to cell B7.

BY - A =SUM(BZ:B6)
A | B | ¢© [ o [ E ]
1
2 128
3 245 The AutosSum of cells B2
through BG is added to cell
4 243 BY. Motice the formula,
a o7 =5UM{B2:B6), defined in
f 187 cell BY.
; I 1EIEIEI_|

Finding the Average of a Range of Numbers

The Average function calculates the average of a range of numbers. The Average
function can be selected from the AutoSum drop-down menu.

To Calculate the Average of a Range of Data:

Type the numbers to be included in the formula in separate cells of column B (Ex:
type 128 in cell B2, 345 in cell B3, 243 in cell B4, 97 in cell B5 and 187 cell B6).




Click on the first cell (B2) to be included in the formula.

Using the point-click-drag method, drag the mouse to define a cell range from
cell B2 through cell B6.
On the Standard toolbar, click on the drop-down part of the AutoSum button.

E -
Select the Average function from the drop-down Functions list.
-

)
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The average of the numbers is added to cell B7, or the cell immediately beneath
the defined range of numbers.
Notice the formula, =AVERAGE(B2:B6), has been defined to cell B7.
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Accessing Excel 2003 Functions

To Access Other Functions in Excel:

210 o | B I U|SE==|F S
BY - A =AVERAGE(EZ BE)
A | B | ¢ | D | E |
1
E 128 The Average of cells B2
3 343 through B6 is added to cell B7.
4 243
g g7| Motice the formula,
B 187 =AVERAGE(BZ:B6), defined
in cell BY.
; I EIZIEI!

« Using the point-click-drag method, select a cell range to be included in the

formula.

«  On the Standard toolbar, click on the drop-down part of the AutoSum button.




If you don't see the function you want to use (Sum, Average, Count, Max, Min),

display additional functions by selecting More Functions.
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The Insert Function dialog box opens.

Mare Functions, T,
L)

There are three ways to locate a function in the Insert Function dialog box:

You can type a question in the Search for a function box and click GO, or

You can scroll through the alphabetical list of functions in the Select a function field, or

You can select a function category in the Select a category drop-down list and review
the corresponding function names in the Select a function field.

Search for a function:

Type a brief description of what vou want ko do and then G0
click. Go
Or seleck a cakeqory: |Date & Time hd

Select a function:

DaTEVALUE
Cah
DaYS360
HOLR Date & Time category.
MIMUTE
MOMNTH e

DATE(year,month,day)

Returns the number that represents the date in Microsoft OFfice Excel
date-time code.

Help on khis funckion [ Ik ] [ Cancel ]

Functions associated with the

Select the function you want to use and then click the OK button.




Naming Worksheets

At the beginning of this course, we learned that the tabs displayed at the bottom of the
screen are named Sheetl, Sheet2 and Sheet3. These are not very informative names.
Excel 2003 allows you to define a meaningful name for each worksheet in a workbook-
Checkbook, Reports, Accounts-so you can quickly locate information.

To Name a Worksheet:

Double-click the sheet tab to select it. The text is highlighted by a black box.

16 o
M 4 » W' Sheetl/sheetz {cheets / |« >
Ready MM

« Type a new name for the worksheet.

16 | v
M 4 » w}Checkbook { Sheet2 / Sheet3 |< ¥
Ready MM

Press the Enter key.
« The worksheet now assumes the descriptive name defined.

Inserting Worksheets

By default, each new workbook in Excel 2003 defaults to three worksheets named
Sheetl, Sheet2 and Sheet3. You have the ability to insert new worksheets if needed or
delete others you no longer want.

To Insert a New Worksheet:




+ Choose Insert = Worksheet from the menu bar.
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« A new worksheet tab is added to the bottom of the screen. It will be named
Sheet4, Sheet5 or whatever the next sequential sheet number may be in the
workbook.

Deleting Worksheets

Any worksheet can be deleted from a workbook, including those that have data in it.
Remember, a workbook must contain at least one worksheet.

To Delete One or More Worksheets:

« Click on the sheet(s) you want to delete.




+ Choose Edit = Delete Sheet from the menu bar.

Edit | ¥Wiew Inserk  Format

Can't Undo Chrl+Z

Can't Repeat kel

da | Cut Chrl4-

23| Copy Chrl+C

|_L'-"‘-Ij Office Clipbaoard. ..

[ Paste Chrl+y
Paste Special. .,

Paste as Hyperlink

Fill »
Clear »
Delete, .

|
Mowve or Copy Sheet, l"'g

| Delete Sheet

4 Find... ChrHF
Replace.., Ctri4+-H
Go To... Chrl+G
Links. ..
Cibject

« The following dialog box appears if the sheet being deleted contains information
on it.

Microsoft Excel

! "_\ Draka may exist in the sheet(s) selected For deletion. To permanently delete the data, press Delete.

[ Delete l [ Cancel ]

«  Click the Delete button to remove the worksheet and all the data in it.

Another way to delete or insert a worksheet is to right-click on the sheet to be deleted and
then select Delete or Insert from the shortcut menu.
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Moving Worksheets

When you move a sheet, you are moving it to a new location in this or another
workbook.

To Move a Workbook:

Select the worksheet you want to move/copy.




Choose Edit = Move or Copy from the menu bar.

Edit | ¥Wiew Inserk  Format

Can't Undo Chrl+Z

Can't Repeat kel
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Delete, .
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Links. ..
Cibject

In the Move or Copy dialog box, use the drop down boxes to select the name of
the workbook you will move the sheet to (the current workbook is the default).
Also define where you want the sheet positioned in the workbook.

Move or Copy E|
Move selected sheets

To book;

Bookz w

Before sheet:
Checkbaoal:

Sheet?
Sheet3
{move to end)

[] create a capy

[ 0] 4 ] [ Cancel




« Check Create a copy to copy it.
+ Click the OK button to move the worksheet to its new location.

Copying Worksheets
When you copy a sheet, you make an exact copy of it.
To Copy a Worksheet:

« Select the worksheet you want to move/copy.

« Choose Edit =+ Move or Copy from the menu bar.

« In the Move or Copy dialog box, use the drop down boxes to select the name of
the workbook you will copy the sheet to (the current workbook is the default).
Also define where you want the sheet positioned in the workbook.

Click the Create a copy checkbox.

Move or Copy @

Move selected sheets
To book:

Bookil w

Before sheet;

Sheet?
Sheet3
{move to end)

[ 0K ] [ Zancel

« Click OK to create an exact copy of the worksheet and move it to the location
specified.

Inserting a row

You can insert a row in a spreadsheet anywhere you need it. Excel moves the existing
rows down to make room for the new one.

To Insert a Row:

« Click anywhere in the row below where you want to insert the new row.




OR

Choose Insert = Rows from the menu bar.

@_‘l File Edit Miew | Insert | Format  Tools Data  window
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= Click in the row below where you want to insert

10 a new row and then choose Insert == Rows

1 from the menu bar.

12

A new row is inserted above the cell(s) you originally selected.

Click anywhere in the row below where you want to insert the new row.




« Right-click and choose Insert from the shortcut menu.

A | B8 | ¢ | b | E |
1
2 |Sales §34 567 .00
3 |Expenses| $1.234.00
4 |Tatal |$35 a1, ol
5 4 Cuk
b =3 Copy
F gD -
g |24 Paste
g Paste Special...
10
11 | Insert. .. D,E
12 Delete. ..
13 Clear Conkents
14
15 4 Insert Comrment
16 1 Format Cells. ..
1; Pick, Fram Drop-doven List...
19 Add Watch
20 Creake Lisk, ..
21 )
53 =% Hyperlink. ..
23 &_‘L Laak Up...
24

« The Insert dialog box opens.

Inserk
() shift cells right
() shift cells down

) Entire column

I Ok I[ Zancel ]

« Choose the Entire Row radio button.
+ Click the OK button.




« A new row is inserted above the cell(s) you originally selected.

A | B | ¢ |

Sales $34 56700
Expenses | 1.234.00

Total 535 B0 .IIIIII

A blank row is inserted between
rows 3 and 4.

D~ 3| M | =

v" Select multiple rows before choosing Insert to add rows quickly. Excel inserts the
same number of new rows that you originally selected.

Inserting a column

In Excel, you can insert a column anywhere you need it. Excel moves the existing
columns to make room for the new one.

To Insert a Column:

« Click anywhere in the column where you want to insert a new column.




OR

Choose Insert = Columns from the menu bar.
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14 Total 215500 2 325.00

15

16 | Monthly Wage 2.400.00

17

18 Savings 24500

19

A new column is inserted to the left of the existing column.

Click anywhere in the column where you want to insert a new column.




Right-click and choose Insert from the shortcut menu.
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« The Insert dialog box opens.

Insert
() shift cells right
() shift cells down

{:} Entire row

][ Cancel ]

« Click the Entire Column radio button in the Insert dialog box.

+ Click the OK button.




« A new column is inserted to the left of the existing column.

A . B | © | D0 | E
1 Monthly Bills | January March
2 Rent BO0.00 BO0.00
3 Gas 45.00 55.00
4 Electric EEI.IIIEII 1 BO.00
& Grocieries 130.00 15EI.EIEI
b Insurance 110.00 110.00
7 | Car Payment 250.00 250.00
g Cable 35.00 35.00
a Internet 50.00 50.00
10| Credit Cards 55.00 155.00
11 Day care a00.00 a00.00
12 Gasoline 50.00 B0.00
13 Misc. 250.00 300.00
14 Total 2.155.00 232500
15 A new column is inserted
16 | Monthly Wage 2.400.00 between the January and
17 March columns.
18 Savings 24500
19

You can also select multiple columns before choosing Insert to add columns quickly.
Excel inserts the same number of new columns that you originally selected.

Deleting columns and rows
Columns and rows are deleted in much the same manner as inserting columns and rows.
To Delete a Row and All Information in It:

« Select a cell in the row to be deleted.
« Choose Edit = Delete from the menu bar.




Click the Entire Row radio button in the Delete dialog box.

A | B | C© |
1 Monthly Bills | January = March
2 Rent B00.00 GO0.00
3 Gas 45.00 55.00
4 Electric ! a0.00 B0.00
5 Grocieries 130.00 150.00
G Insurai
g Cablq pgjere
£l Internt  ~ opiey o fot
1d Credit C ) shift cells up
11 Day cay ;
12 Gasoli :
13 Misc] O Entire column
14 Tota
15 [ 04 ] [ Cancel
16 | Monthly Ve oo
17
18 Savings 24500
19
Click the OK button.

To Delete a Column and All Information in it:

Select a cell in the column to be deleted.
Choose Edit = Delete from the menu bar.




Click the Entire Column radio button in the Delete dialog box.

Monthly Wage

Savings

Click the OK button.

Adjusting column widths

A | E | ¢ | b | E |
1 Monthly Bills = January March
2 Rent B00.00 B00.00
3 Gas 45.00 55.00
4 Electric 50.00 B0.00
5 Grocieries 130.00 150.00
B Insurance 110.00 110.00
7 | Car Payment 250.00 250.00
g Cable
9 Internet IJglete @
10| Credit Cards Delete
11 Day care O shift cells left
12 Gasoline () shift cells up
13 Misc.
14 Total
15
16
17
18
19

By default, Excel's columns are 8.43 characters wide, but each individual column can be
enlarged to 240 characters wide.

If the data being entered in a cell is wider or narrower than the default column width, you
can adjust the column width so it is wide enough to contain the data.

You can adjust column width manually or use AutoFit

To Manually Adjust a Column Width:

Place your mouse pointer to the right side of the gray column header.

The mouse pointer changes to the adjustment tool (double-headed arrow).
Drag the Adjustment tool left or right to the desired width and release the mouse
button

To AutoFit the Column Width:

Place your mouse pointer to the right side of the column header.
The mouse pointer changes to the adjustment tool (double-headed arrow).




« Double-click the column header border.
« Excel "AutoFits" the column, making the entire column slightly larger than the
largest entry contained in it.

To access AutoFit from the menu bar, choose Format = Column - AutoFit Selection.

Adjusting row height

Changing the row height is very much like adjusting a column width. There will be
times when you want to enlarge a row to visually provide some space between it and
another row above or below it.

To Adjust Row Height of a Single Row:

« Place your mouse pointer to the lower edge of the row heading you want to
adjust.

« The mouse pointer changes to the adjustment tool (double-headed arrow).

« Drag the Adjustment tool up or down to the desired height and release the mouse
button.

To AutoFit the Row Height:

« Place your mouse pointer to the lower edge of the row heading you want to
adjust.

« The mouse pointer changes to the adjustment tool (double-headed arrow).

« Double-click to adjust the row height to "AutoFit" the font size.

« Excel 2003 "AutoFits" the row, making the entire row slightly larger than the
largest entry contained in the row.

Inserting a cell

When working in an Excel 2003 worksheet, you may need to insert or delete cells
without inserting or deleting entire rows or columns.

To Insert Cells:
 Select the location where the new cell(s) should be inserted. It can be a single cell
or a range of cells.

« Right-click and choose Insert.

Note: You could also choose Insert = Cell on the menu bar.




A | B [ e | b | E |

1
2
3 Sales 34 567 .00
4 Expenses | 1,.234.00
5 35 601,00
5 & | Cut
7 o3 Copy
g [ Paste
10| Right-click on the cell (C5) Paste Special...
11 where the new cell is to be

inserted. | Insert..  p
12 L
13| Click the Insert option in Delete...
14 the drop-down menu. sy Ssafiertis
12 A Insert Comment
17 % Format Cells.,.,
13 Pick From Drop-doven List. ..
21 Create List. ..
gg W Hyperlink...
24 4 LookUp...
25

The Insert dialog box opens. Select either:
Shift cells right to shift cells in the same row to the right.

Shift cells down to shift selected cells and all cells in the column below it

downward.

Insert §|

Imsert
() shift cells right

) Entire row
) Entire calunnn

[ Ok ] [ Cancel ]

Insert dialog box

Choose an option and click the OK button.




«  Your result displays in the spreadsheet.

v" Remember, you can also use the Insert dialog box to insert or delete columns and

TOws.

Deleting a cell

A | B | ¢ | D |

1

2

3 Sales 34 567 .00

4 Expenses | 1,7234.00

] ,I |

B Inserted 35,801.00

7 Cell

g

To Physically Delete the Cell from the Spreadsheet:

« Right-click and choose Delete.

[ SO I S I S S U U U VY Y [P U T Y

A | B | ¢ 1 o | e | F
Sales 34 A&7.00
Expenses 1.234.00
3I5801.00 & Cut
=3 Copy
(7% Paste
Paste Special. ..
Insert...
| Delete. ..

Lg L

2

M
by

Clear Conkents

Insert Comment

Eormat Cells, ..
Pick From Drop-down Lisk, .,
Create List, ..,

Hyperlink...

Look Up...

« The Delete dialog box opens. Select either:




«  Shift cells left to shift cells in the same row to the left.
«  Shift cells up to shift selected cells and all cells in the column above it upward.

A | B | ¢ | b | E |
| 1]
| 2 |
| 3 | Sales 34 567.00
4 Expenses  1.234.00
| 5 |
| 6 |
| 7 35,801.00
a
g
10 | Delete
11 | You can delete
W multiple cells at the
—= same time.
13
14| ) Entire pov
B {3 Entire column
16 |
17 [ o || cancel
18]

1

« Choose an option and click the OK button.
«  Your result displays in your spreadsheet.

Merging cells

In Excel 2003, you have another alignment option available to you: merge and center.
This is performed when you want to select one or more cells and merge them into a
larger cell. The contents will be centered across the new merged cell.

The picture below shows why we might want to merge two cells. The spreadsheet
presents Last Month and This Month Sales and Expenses for Sally. Notice that Sally's
name appears above the Last Month column. To evenly center Sally's name across the
two cells we would perform a merge and center.

| o " E JF ] &6 [ H [ 1 [ J |

fuskar CHEEmMA | WWE WILL MERGE THESE
w TwiD CELLS

To Merge Two Cells Into One:




« Select the cells that you want to merge. It can be cells in a column, row or both
columns and rows.

« Click the - Merge and Center button on the standard toolbar.

|98 = -3l 6@ e -0 - B I U EE
=EmrA,
D | E | F | G | H | | 1 | I Merge and Centf

[ UShAN CHEEMA, !

Using the Standard Toolbar to Align Text and Numbers in Cells

You've probably noticed by now that Excel 2003 left-aligns text (labels) and right-
aligns numbers (values). This makes data easier to read.

A E | " | D
1
2
3 Sales 34 567.00
4 Exp|ensea 1,234.00
5 |
5] Text, by default, is Mumbers, by default,
7 left-aligned in are right-aligned in
a Excel 2003. Excel 2003.

You do not have to leave the defaults. Text and numbers can be defined as left-aligned,
right-aligned or centered in Excel 2003. The picture below shows the difference between
these alignment types when applied to labels.

right-aligned text
left—aligned text

centered text

Text and numbers may be aligned using the left-align, center and right-align buttons of
the Formatting toolbar:




Merge and Center
-

>N
Right-align
.

Left-align Cente

To Align Text or Numbers in a Cell:
« Select a cell or range of cells
+  Click on either the Left-Align, Center or Right-Align buttons in the standard
toolbar.
« The text or numbers in the cell(s) take on the selected alignment treatment.

Fill

"Fills" the cell with the current contents by repeating the contents for the width of the
cell.

Justify

If the text is larger than the cell width, Justify wraps the text in the cell and adjusts the
spacing within each line so that all lines are as wide as the cell.

Center Across Selection

Contents of the cell furthest to the left are centered across the selection of cells. Similar
to merge and center, except the cells are not merged.

To Change Horizontal Alignment using the Format Cells Dialog Box:

« Select a cell or range of cells.
« Choose Format - Cells from the menu bar.
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(You could also right-click and choose Format Cells from the shortcut menu.)

The Format Cells dialog box opens.
Click the Alignment tab.

Format Cells

General
Yertical:

Biotkom

Text conkrol

Text dire

Context

Text abgriment
Horizaontal:

] Wrap text
[ shrink ta Fit

[ Merge cells
Right-to-left
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onk Border Patterns | Probection
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Orienkation
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*
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=
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. Text )
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i} = | Dearees

Ok ” Cancel I

Click the Horizontal drop-down menu and select a horizontal alignment

treatment.

Click OK to apply the horizontal alignment to the selected cell(s).




To Change Vertical Alignment using the Format Cells Dialog Box:

« Select a cell or range of cells.
« Choose Format -+ Cells from the menu bar.

(You could also right-click and choose Format Cells from the shortcut menu.)

« The Format Cells dialog box opens.

« Click the Alignment tab.

«  Click the Vertical drop-down menu and select a vertical alignment treatment.
« Click OK to apply the vertical alignment to the selected cell(s).

Changing Text Control

Text Control allows you to control the way Excel 2003 presents information in a cell.
There are three types of Text control: Wrapped Text, Shrink-to-Fit and Merge Cells.

» The Wrapped Text wraps the contents of a cell across several lines if it's too large
than the column width. It increases the height of the cell as well.

# Shrink-to-Fit shrinks the text so it fits into the cell; the more text in the cell the
smaller it will appear in the cell.

» Merge Cells can also be applied by using the =2 Merge and Center button on the
standard toolbar.

To Change Text Control using the Format Cells Dialog Box:

« Select a cell or range of cells.

« Choose Format - Cells from the menu bar.

« The Format Cells dialog box opens.

« Click the Alignment tab.

« Click on either the Wrapped Text, Shrink-to-Fit or Merge Cells check boxes-or
any combination of them-as needed.

+  Click the OK button.




Changing Text Orientation

The fourth type of cell alignment in the Format Cells dialog box is Text Orientation,
which allows text to be oriented 90 degrees in either direction up or down.

To Change Text Orientation using the Format Cells Dialog Box:

« Select a cell or cell range to be subject to text control alignment.

« Choose Format - Cells from the menu bar.

« The Format Cells dialog box opens.

« Click the Alignment tab.

« Increase or decrease the number shown in the Degrees field or spin box.
«  Click the OK button.

Formatting Date in the Format Cells Dialog Box

The date can be formatted in many different ways in Excel 2003. Here are a few ways it
can appear:

October 6, 2003
10/06/03
10-Oct-03

To Format the Appearance of a Date in a Cell:

« Select a cell or range of cells.

« Choose Format -+ Cells from the menu bar.
« The Format Cells dialog box opens.

« Click the Number tab.




« Click Date in the Category drop-down list.

Format Cells EJ El

Murber | Alignment Font Border | Patterns | Prokection
Cakegary: Sample
General
Mumber
Currency Tvpe:
" *wednesday, March 14, 2001
Time a(14
Percentage 3114701
Fraction 03/14/01
Scientific 14-Mar
Text 14-Mar-01 v
Special -
Cuskari Locale {location):
English (Uniked Skates) L

Date Farmats display date and time serial numbers as date values, Except For
ikems that have an asterisk (*), applied formats do nok swikch date orders
with the operating swstem,

[ Ok l[ Cancel ]

« Select the desired date format from the Type drop-down list.
+  Click the OK button.

Formatting Time in the Format Cells Dialog Box

The time can be formatted in many different ways in Excel 2003. Here are a few ways it
can appear:

13:30
1:30 PM

To Format the Appearance of Time in a Cell:

« Select the range of cells you want to format.
« Choose Format - Cells from the menu bar.
« The Format Cells dialog box opens.

« Click the Number tab.




+ Click Time in the Category drop-down list.

Format Cells EJ El

Murber | Alignment Font Border | Patterns | Prokection
Cakegary: Sample
General
Mumber
Currency Tvpe:
Accounking *11300:55 PM
Dats 13:30
b
Percentage 13:30:55
Fraction 1:30:55 FM
Scienkific 30:55,2
Text 37:30:55 v
Special ;
Cuskam Locale {location);
English (Uniked Skates) w

Time Farmats display dake and time serial numbers as time wvalues, Excepk For
ikems that hawve an asterisk (*), applied Formats do nok swikch date or kime
orders with the operating system.

[ Ok l[ Zancel ]

« Select the desired time format from the Type drop-down list.
+  Click the OK button.

Change Font Type, Size and Color

In Excel 2003 a font consists of three elements: Typeface, or the style of the letter; Size
of the letter; and Color of the letter. The default font in a spreadsheet is Arial 10 points,
but the typeface and size can be changed easily.

Selecting a Font Typeface:

The amount of typefaces available for use varies depending on the software installed on
your computer.




A [ B | ¢ | b [ E |
1
2
3 Examples of different typefaces:
4
5 Arial
B Century achoolbock
7 Courier
i Impact
=) Monctype (brsiva
10 Times Mew Eoman
11 YVerdana
12

To Apply a Typeface to Information in a Cell:
« Select a cell or range of cells.
« Click on the down arrow to the right of the Font Name list box on the Formatting

toolbar.

Arial =

« A drop-down list of available fonts appears.

- | = - | @ EM [-liz - | B I U =

- B Arial ) B ,Ifl,genc':lrFEi ”~ :

L B | ¢ | |2 Albertus MT &3
& Albertus MT Lt

Examples of differen T ﬁL'-EERIM
& Antique Olive Compact

E‘ & Antigue Olive EKoman

Centurj; Schoolbooﬁ 8 Apple Chancery

Courier T Arial Black E!

Impact - T Arial Marrow

Monotype Corstva % Arial Rounded MT Bold

Times New Roman | % prjal Unicode MS v

Yerdana

+ Click on the Typeface of your choice.
« The selection list closes and the new font is applied to the selected cells.




Change font type, size and color (continued)

To Apply a Font Size to Information in a Cell:

The "Font Size" list varies from typeface to typeface. The Arial font sizes, for example,
are 8,9, 10, 11, 12, 14, 16, 18, 20, 22, 24, 26, 28, 36, 48, 72.
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Examples of different sizes:

Arial, &

Arial, 10

Arial, 12
Arial, 14
Arial, 16
Arial, 18

Arial, 20

Select a cell or range of cells.
Click on the down arrow to the right of the font size list box on the Formatting

toolbar.

n -
A drop down list of available font sizes appears.

i Arial -~ B 7 U

g A
[ |
11

12
14
16
18
20
22
24
26 ™

Click on the Font Size of your choice.
The selection list closes and the new font size is applied to the selected cells.




To Apply Color to Information in Cells:

« Select a cell or range of cells.
« Click on the down arrow to the right of the font color list box.

A ~

« A drop-down list of available colors appear.

|I Aukonmatic |
EEEN I@I ]

[ | EEN L
m m IDark Blue
[ | [ |

Click on the color of your choice.
« The selection list closes and the new font color is applied to the selected cells.

Underline, Italics and Bold

In addition to the typeface, size and color, you can also apply Bold, italics, and/or
underline font style attributes to any text or numbers in cells.

To Select a Font Style:

« Select a cell or range of cells.
« Click on any of the following options on the Formatting toolbar.

B I O
« Bold button (Ctrl + B).

« [talics button (Ctrl + I).
«  Underline button (Ctrl + U).

« The attribute(s) selected (bold, italics, or underline) are applied to the font.

The Bold, /talics, and Underline buttons on the Formatting toolbar are like toggle
switches. Click once to turn it on, click again to turn it off.




Design and Apply Styles

Styles can save a lot of time when formatting a spreadsheet. A Style is a unique
collection of font attributes (Number, Alignment, Font, Border, Patterns and Protection).
Many different styles can be created in a spreadsheet, each with different attributes and
names. When applied to a cell, information in it resembles the attributes defined for that
style.

To Apply a style:

« Select the cell or range of cells.
« Choose Format -+ Style from the menu bar.

Format | Tools Data Window

s Cells... Chrl+1
Ry 3
Column 3
Sheet 3
autoFormat...

Conditional Formatting. ..
Skvle, .. [L

« Select a style from the Style name drop-down list.

Style name: v 0K
Style includes

Cancel
Mumber General

Alignment  General, Botkomn Aligned Madify. .
Font Arial 10

Border Mo Borders

Patterns Mo Shading

Protection  Locked

You can change the style attributes (Number, Alignment, Font, Border, Patterns and
Protection) for any Style Name.

You can create new styles by clicking on the Add button in the Style dialog box.




Adding a Border to Cells

Borders can be applied to cells in your worksheet in order to emphasize important data
or assign names to columns or rows.

To Add a Border to a Cell or Cell Range:
« Select a cell or range of cells.

Click on the down arrow next to the Borders button.
The Border drop-down appears.

—®BOO0

_ Draw Borders,.,

Choose a borderline style from the Border drop-down menu.

« The selected cells display the chosen border.

Adding Color to Cells

Colors can be applied to cells in your worksheet in order to emphasize important data or
assign names to columns or rows.

To Add Color to a Cell:

« Select a cell or range of cells.

+  Click the down arrow next to the Font Color button. A Font Color drop-down
menu displays.




« Choose a font color from the Font Color drop-down menu.

|B I U |E==H[EE| = -O-A -8

| L | i | ] | 0l e Fill

The color red in the cells shown at
the left was selected from the Color
drop-down menu.

« The selected cells display the color.

Understanding the Different Chart Types

Excel 2003 allows you to create many different kinds of charts.

Area Chart

An area chart emphasizes the trend of each value over time. An area chart also shows
the relationship of parts to a whole.

-4 [a] PN
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Column Chart

A column chart uses vertical bars or columns to display values over different categories.
They are excellent at showing variations in value over time.
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Bar Chart

A bar chart is similar to a column chart except these use horizontal instead of vertical
bars. Like the column chart, the bar chart shows variations in value over time.

T
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Line Chart

A line chart shows trends and variations in data over time. A line chart displays a series
of points that are connected over time.

Pel
AHl7

Pie Chart

A pie chart displays the contribution of each value to the total. Pie charts are a very
effective way to display information when you want to represent different parts of the
whole, or the percentages of a total.
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Other Charts

Other charts that can be created in Excel 2003 include: Doughnut; Stock XY (scatter);
Bubble; Radar; Surface; or Cone, Cylinder, and Pyramid charts.

Identifying the Parts of a Chart

Charts are a visual representation of data in a worksheet. Charts make it easy to see
comparisons, patterns, and trends in the data.

1 Asia Africa North Ame

2/ 0uarter 1 $18 000.00 $12,000.00 15 ,000.0

E[ Quarter 2 $14 750.00 $13,500.00 $12,200.00 Source Data

M OQuarter 3 $12 500.00 $15,000.00 $13,260.00

] WMS,DDD.DD 14 500.00 514 000,

[ Chart Title

7

8 World Wide Widgets

9

10 $18,000.00

11

12 $16,000.00

13 $14,000.00 1 ] ‘
14 Legend
15 $12,000.00 — Py
15 Value Axis ——¥10,000.00 1— — A

17 W Africa

18 $8,000.00 1= | |OMorth America

19 $6,000.00 1— —

20

21 $4,000.00 1+— |

22 ™

2 $2,000.00 1 = "Data Series

24 $0.00 T T T

25 Giarter 1 Guarter 2 Cuarter 3 warter 4

26

gg Category Axis

29




Source Data

The range of cells that make up a chart. The chart is updated automatically whenever the
information in these cells change.

Title

The title of the chart.

Legend

The chart key, which identifies each color on the chart represents.
Axis

The vertical and horizontal parts of a chart. The vertical axis is often referred to as the Y
axis, and the horizontal axis is referred to as the X axis.

Data Series

The actual charted values, usually rows or columns of the source data.
Value Axis

The axis that represents the values or units of the source data.
Category Axis

The axis identifying each data series.

Creating a Chart Using the Chart Toolbar

Charts can be created in a number of ways in Excel 2003. The quickest way to create and
edit your charts is to use the Chart Toolbar.




To Show the Chart Toolbar:
+ Choose View = Toolbars = Chart on the menu bar.

Wiew | Imsert  Format  Tool

Marmal

U Page Break Preview

| Toolbars L Standard
Zoom, .. Formatting
¥ Borders
| Chart

[
Conkral Tu:u:ull:u:uxl}\5
Drawing
External Data

Faorms

Formula Auditing

Parts of the Chart Toolbar:

Chart Type By Row

Format By Column

Chart Area -ﬁ-\|uﬂv|lﬁ|g| P
Legend Angle
Chart Objects List Box Data Table Text

Chart Objects List Box

This list box lets you select different parts of a chart for editing.
Format Chart Area

Used to format that part of the chart which is currently selected.
Chart Type

A drop-down menu that lets you select different types of charts. The chart type can be
changed at any time.




Legend

Used to show or hide the chart legend.

Data Table

Used to show or hide the actual Source Data used to create the chart.
By Row

Plots the Data Series using the row labels (Y-axis).

By Column

Plots the Data Series using the column labels (X-axis).

Angle Text

Use to rotate the angle of the X-axis and Y-axis labels.

Creating an Embedded Chart

Charts can be created in either of two ways in Excel 2003: Embedded Charts and a
Chart Sheet. Excel creates an embedded chart by default. An embedded chart is placed
on the same worksheet as the source data used to create it.

To Embed a Chart in a Worksheet:

« Choose View = Toolbars = Chart on the menu bar.
« Select the range of cells that you want to chart. Your source data should include at
least three categories or numbers.
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1 Asia Africa North America
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»  Click the chart type pull down on the chart toolbar and select the chart that you
would like to use.
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«  Open the chart options dialog box: Chart - Options to add a title to your chart.

Chart | Window Help

Chart Type...

| Chart Options. .. [

3-D View, .,

-




« Select the Titles tab and type the title of the chart in the Chart Title text box.

Chart Options E]E]

[ Thles || Axes | Gridines | Legend = Datalabels | Data Tabls

Chart, Litle:

Buarter 4
Category (X)) axis:

Busrtee 3 O Morth Americd
Value (V) axis: | Aftlen

Ehinrge 2 @ Asia

[ 1
$0.00 rs.llzu:m $10,00 |.|5I.l:|u $20,00
L0 Q00 000 Q00
O | [ Cancel -I

Different charts work best with different data. A pie chart, for example, can only display
one data series at a time.

Excel 2003 includes a 4-step Chart Wizard that you can use to guide you through the

steps for creating a chart. Highlight the cell range you want to chart, choose Insert -
Chart on the menu bar and follow the instructions in the wizard.

Creating a chart sheet

Sometimes, you may want to create a chart and place it on a separate sheet in the
workbook. This is called a Chart Sheet. Chart sheets can make your charts stand out,
particularly when working with complicated spreadsheets.

To Move an Embedded Chart to a Chart Sheet:

o Create an embedded chart.
« Select the chart to be moved to a chart sheet.




Choose Chart = Location from the menu bar.

Chart | Window  Help

Chart Twpe...
Source Daka, ..

Chart Opkions, ..

Location. .. [

add Data...
add Trendline. ..
3-D View, .,

In the Chart Location dialog box, select the As a new sheet radio button.

(The As object in radio button adds the chart as an embedded object on the
worksheet.)

Chart Location

Flace chart:

(&) As new shest:

s
e
gl.l.l_E ) s object in: Sheetl w

[ 0K l[ Cancel ]

Click the OK button. The chart is displayed on a separate Chart Sheet in the
Workbook.
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You can also use the Chart Location dialog box to rename the Chart Sheet.

Moving a chart

An embedded chart can be moved anywhere on a worksheet. The easiest way to move a
chart is to drag it around the worksheet.

To Move a Chart:

« Click anywhere on the white space in the chart and use the cursor to drag the
chart anywhere on the worksheet.
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« Release the mouse button to place the graph in its new location.

Deleting a Chart

Any embedded chart or chart sheet can be deleted from a worksheet. A chart sheet is
deleted in the same manner a worksheet is deleted. This section discusses how to delete
an embedded chart.

To Delete a Chart:

« Click anywhere on the white space of the chart area to select the chart.
« Press the Delete key on your keyboard.

If you have difficulty deleting a chart, click anywhere outside of the chart and then select
the chart again.




Setting Page Margins

The Page Margins define where on the page Excel will print the worksheet. By default,
the top and bottom margins are set at 1 inch in Excel 2003. The left and right margins are
set at .75 inch. Margin settings can be changed to whatever you want. Different margins
can be defined for each worksheet in the workbook.

To Change the Margins in the Page Setup Dialog Box:

« Select the correct worksheet.
« Choose File = Page Setup from the menu bar.

Filz | Edit Miew Insert  Fo

] Mew,., Chrl-1

. Open... Chrl4
Close

lml save Ctrl+5
Save fs

4 Save as Web Page...

#1 File Search,..
Permission »

Web Page Preview

| Page Setup... P

4 Prink Preview Vi
4| Print... Chrl+P
Send To 2

Exit
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+ Select the Margins tab.

Page Setup
Page Marglns Header/Footer | Chart
1 = os =
Cipkions. ..
Left: Right:
07 & 075 &
Boktarn: Foaker:
1 E 0.5 3
Zenter on page
[ I, ][ Cancel ]

« Use the spin box controls to define the settings for each page margin-Top,
Bottom, Left, Right, Header and Footer.
+  Click the OK button to change the margin settings.

Changing the Page Orientation and Paper Size

The Page tab of the Page Setup dialog box lets you change page orientation (portrait or
landscape) or paper size (e.g., letter size or legal size). The default paper size in Excel
2003 is 8.5 X 11 inches, with a portrait orientation (prints up and down on the long side
of the page). A landscape orientation, on the other hand, prints up and down on the short
side of the page.

Orienkation

[
) Portrait (%) Landscape

To Change Page Orientation:

« Select the correct worksheet.




« Choose File = Page Setup from the menu bar.
« Click on the Page tab.

Page Setup

Page Margins || Header/Fooker Sheet

Crienkation
L
[
A Qs
Scaling options. ..

(%) adjust ko: |100 % % normal size

I Ekko: |1 % | pageds) wide by |1 % |al

Paper size: 8.5 11" Letter
Print guality: | 600 dpi L
First page number: Auko

[ 04 ][ Cancel ]

« Choose an Orientation (Portrait or Landscape) for the worksheet.

Select a Paper Size from the list of available paper size options that appear in the
list box.

Click on the paper size.

Click the OK button to accept the page settings.

The Page tab of the Page Setup dialog box lets you shrink the spreadsheet data so it fits
on a specified number of pages when you print. Click the Fit to: option button and enter
the desired number of pages wide and pages tall.

The Page tab of the Page Setup dialog box lets define the resolution of the print job.
Print Quality is measured in dpi, or dots per inch. High dpi provides a better print
quality.




Creating Headers and Footers

Headers and Footers can be added to any worksheet, although not required. A Header is
any information that appear at the top of each page. A Footer prints at the bottom of the
page. If you want a header or footer inserted onto a page then you will have to define
them. Excel 2003 defaults to no header and no footer.

To Create a Header:

« Choose File -+ Page Setup from the menu bar.
« Select the Header/Footer tab in the Page Setup dialog box.

Page Setup

Page | Margins || Header/Footer || sheet

Header:

Qpkions. ..

(none) 3 Cp

[ Custom Header. .. ] [ Zuskom Fooker. .. ]

Foater:

(nione) a

[ Ok ][ Cancel ]

« Click the Header drop down list and select and of the predefined headers:

OR

click the Custom Header button to create your own header. Follow the
instructions in the Header dialog box to make your entry.




To Formak bext: select the text, then choose the Font button.

Toinsert a page number, date, time, file path, filename, or tab name: position the
insertion poink in the edit box, then choose the appropriate bukton, Cancel

To insert picture: press the Insert Picture button. To format your picture, place the
cursor in the edit box and press the Format Picture button,

.,

Left section: Q:nter seckion: _R_ﬁj‘lt section:
Page &[Page]

« Click the OK button to return to the Page Setup dialog box.
To Create a Footer:
+ Choose File =+ Page Setup from the menu bar.

« Select the Header/Footer tab in the Page Setup dialog box.
«  Click the Footer drop down list and select one of the predefined footers.

Foaker:

(mane) |rv
(none) ~

FPage 1
Sheetl [\!5

OR

Click the Custom Footer button to create your own footer. Follow the
instructions in the Footer dialog box to make your entry.

v" You can insert Placeholder buttons into both the header and footer to format text,
insert page numbers, date, time, filename, or tab name. Excel replaces those placeholders
with the information each represents when the worksheet is printed. Follow the
instructions in the Header and Footer dialog boxes.

Creating Sheet Settings

The Sheet tab in the Page Setup dialog box provides additional print options you may
want to add to your worksheet.




Page Setup @@

.....................

Page Margins | Header[Footer || Sheet |

Frink area: BT

Prink titles
T Print Prewvieyw

Bows to repeat at bop: e

b
=

Options...
Colurnine bo repeat st |eft; B

Prink
[] Gridines [ ] R and eolumn headings

|_] Black and whike Comments: | (Nore)

[] Draft guality Cell errors as: v -

Page order

(%) Down, then over
() Over, then down

[ O I [ Cancel

Print Area

By default, Excel prints from the A1 to the last occupied cell in a worksheet. You can
specify a different range of cells to print.

Print Titles

Prints column and row labels on each page of the printout. Specify these rows or columns
in the Rows to Repeat at Top and Columns to Repeat at Left textboxes.

Print - Gridlines

Determines whether gridlines are printed. However, turning off gridlines does not affect
their appearance in Normal View.

Print - Black and White

If you used colors in your worksheet but don't want to waste the ink in your color printer,
use black and white.

Print - Draft Quality
Choose draft quality to print the worksheet without gridlines or graphics.

Print - Row and Column Headings




Click this option to include row numbers and columns letters in your printed document.

Page Order

Determines the order in which worksheets are printed.

Preview a Page before Printing

Excel 2003 provides a Print Preview capability that shows a smaller picture of the
printed page directly on the computer screen. Print Preview is a good way for you to
review the formatting and make sure the columns, rows and margins appear exactly
where you want them.
To Print Preview:

+ Choose File = Print Preview on the menu bar, or

Click the Print Preview button on the standard toolbar.
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In Print Preview window, the document is sized so the entire page is visible on
the screen. Simply check the spreadsheet for overall formatting and layout.

Inserting and Removing a Page Break

There are two different kinds of page breaks in Excel: soft page breaks and hard page
breaks. A soft page break is automatically inserted into a spreadsheet when there is too
much data to fit on one page. A hard page break is one that you can insert into a
spreadhseet, wherever you want it to appear.

To Insert a Page Break:

Move the cursor to the row where a page break needs to be inserted. This row will
be the first row on the new page.
Choose Insert =+ Page Break from the menu bar.

Insert | Farmak  Tools  De

Cells, ..

Rows
Columns
Worksheet

'ﬂ Chart...

Symbal. .,

| Page Break *E |

Jf&  Eunckion...

Marme ]
. Comrment

Picture ]
£.4 | Diagram...

Chiject,..
M Hyperlink,.,  Chrlk
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A page break, indicated by a dashed line, is inserted into the worksheet.

To Delete a Page Break:

Move the cursor to the row where a page break appears
Choose Insert = Remove Page Break from the menu bar.




Printing a Worksheet or Workbook

Printing in Excel is much like printing in other Office applications like Microsoft Word.
As previously mentioned, Excel defaults to printing the entire worksheet.

To Print a Worksheet:

o Choose File = Print from the menu bar.

File | Edit Wiew Insert Fo

1 e, Chrl+n

. Open... Chrl+0
Close
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Save fs
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The Print dialog box opens.

Print
Prinker

M
Stakis:
Typa:
Where:

Comnmenk:

v
Ide

HP DeskJet 1220C

LPT3:

Prink range
® al
() Page(s)  From:

Copies
Mumber of copies:

EN

| To:
Print what
() Selection

(%) Active sheek(s)

() Entire workbook

id|3

Find Printer. ..

[] Prink ko file

1

(84

Preview

printer in your home or office, Excel will default to that
In Print Range, choose whether to print All or a certain
From n to y, where n and y are the beginning and endin

Specify the Printer Name where the spreadsheet will print. If you only have one

printer.
range of pages (Pages
g page numbers.

In Print what, choose whether to print a Selection, the Active sheet or the

Entire Workbook (all worksheets in the workbook). Excel defaults to the Active

Sheset.

Click the OK button to print the worksheet.

Choose the Number of Copies to print by clicking on the up or down arrows.

v Don't print your Excel spreadsheet without checking spelling first! Excel includes two

tools to help correct spelling errors: AutoCorrect and Spelling.

Using AutoFilter

Watch the video! (1:05 min) - Tips for watching our videos.

The AutoFilter feature makes filtering, or temporarily hiding, data in a spreadsheet very

easy. This allows you to focus on specific spreadsheet entries.

To Use AutoFilter:



http://www.gcflearnfree.org/PopUps/VideoTips.aspx
http://www.gcflearnfree.org/content/screencasts/shared/player_675x513.aspx?screenCast=ex03/Excel_AutoFilter

« Select Data from the main menu.
+ Select Filter = AutoFilter.
« Click the drop-down arrow next to the heading you would like to filter.

# Click the drop-down arrow again and select All to display all of your original data.

Applying and Modifying Cell Formats

To Apply and Modify Cell Formats:

« Use your mouse to select the cells you want to modify.

« Select Format = Cells from the main menu. The Format Cells dialog box will
appear.

« Decide how you want to format the cells.

« Select the tabs that allow you to make the desired changes.

« Use the Format Cells drop-down menus and tools to make the desired changes.

« Click OK.
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Special (41,234, 10
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Currency Formats are used for general monetary values, Use Accounking
fFormats to align decimal poinks in a column,

Ik ] [ Cancel

In the Format Cells Dialog Box You Can Change:

«  Number Formatting
« Alignment Formatting




Font Formatting
Border Formatting
And More!
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